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The purpose of this tutorial is to help some non-English OM. BecauseKOPIRhas made great video
tutorial for configuring many settings ICOM IC-7300, but they are in English. A big thanks to him
(KOPIR ) For his great help video

This is set 1 Com port for CAT System 1 and another port to transmit AF, PTT, emissions
Modulation.

So yes, some purists will say to the CW response generated by PC when Contest is cheating. But
many contester or shipping do, but keeps playing the sound to hear the caller. In short, a great help
to CW operators.

The best and most effective being the reading sound (ear) for decoding low CW signals when
contest.

But | remember with N1IMM there is the possibility of using fldigi for CW reception. But especially
useful for RTTY contest.

Who knows, if there is demand, I will be a trial and why not an installation tutorial config and
interfacing with NIMM.

Consider adding ferrites on these two cables, as with HF, you may lose the connection and the
connection CAT soundcard ICOM, etc ...

Remember to put USB-D for rtty, psk otherwise it will not work.

29/10/19: DATA menu change MOD OFF MIC, otherwise no microphone for voice usb. Capture tutorial to date.
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Installing CI-V & USB cables and drivers on PC

=}

For that you need :

a USB cable a Cl-V cable(About 20 €)Order

RADIS

You must first install the icom drivers for the USB cable and Prolific for CI-V (to do this, use the
drivers provided on the CI-V cable for USB and CD (driver IC7300 icom website).

So you can connect two cables afterwards and you will have 2 COM ports in the config panel.

e COM4 for CIV (Prolific USB to serial Comm Port)
e COMS for USB (Silicon Labs USB to UART Bridge)

Fichier Action Affichage ?

& @ Hml e

' fovg-PC|
. B, Cartes graphiques
»-&¥ Cartes réseau
»-"§ Cartes série multi-ports
b & Claviers
> -8 Contréleurs audio, vidéo et jeu
.. § Contréleurs de bus USB
b g Controleurs IDE ATA/ATAPI
=] Lecteurs de disque
. Lecteurs de DVD/CD-ROM
» B Moniteurs
i 48 Ordinateur
b 03 Périphériques d'interface utilisateur |
> -8 Périphériques systéme |
I Ports (COM et LPT)
YF ELTIMA Virtual Serial Port (COM10)
-7 ELTIMA Virtual Serial Port (COMI1)
Y ELTIMA Virtual Serial Port (COM12)
YF' ELTIMA Virtual Serial Port (COM9) |
Y% Port de communication (COM1)
IF Port imprimante ECP (LPT1)
'? Prolific USB-to-Serial Comm Port (COM4)
9 '? Silicon Labs CP210x USB to UART Bridge (COMS)
Processeurs
I Souris et autres périphériques de pointage

S
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1C-7300 SETUP

Go to: Menu> Set> connectors

533 CONNECTORS
Tone Control/TBW ACC/USB Output Select

ACC/USB AF Output Level
Jrmm

3.\ Function

¥ | ACC/USB AF sQL
Connectors
| |

Display ACC/USB AF Beep/Speech... Output

CONNECTORS CONNECTORS

ACC/USB IF Qutput Level DATA MOD
[ —

ACCMOD Level External Keypad

v
USB MQOD Level Clv

DATA OFF MOD o USB Serial Function

Then in menu, set, connector, VIC.
Note the CI-V address (here 94H)

Note also the port speed CI-V Baud Rate here 19200

/ Cl-v
Cl-V Baud Rate Cl-V Output (for ANT)

Cl-V Address Cl-V USB Port
Cl-V Transceive ¥ | CI-V USB Baud Rate

Cl-V USB—REMOTE Transceive Address Py Cl-V USB Echo Back

Menu set, connector, USB Send / Keying

CONNECTORS USB SEND/KEYING
USB SEND

USB SEND/Keying USB Keying (CW)

USB Keying (RTTY)

Inhibit Timer at USB Connection

The is and PTT for modes USB is RTS
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Further details on parameters for adjusting the show later in emission test:

setting modulation ALC and rtty etc. (USB D) by | Selects the connector to the input of the

37% if it makes a "pop" every passage TX modulation signal when the "DATA" mode.
Therefore does not activate the microphone
CONNECTORS connector face.

ACC/USB IF Output Level

—

CONNECTORS

DATA MOD
ACC MOD Level

USB MOD Level External Keypad

DATA OFF MOD Cl-v

USB Serial Function

Select the connector for the input of the
modulation signal when the "DATA" mode is not
activated. Sending signal from the PC even in
normal USB mode
CONNECTORS
ACC/USB IF Output Level

—

ACC MOD Level

USB MQOD Level

DATA OFF MOD
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HRD SETUP for connection to IC-7300

Start HRD.
Click "NEW"
Select IC-7700 as my free version of HRD, the IC-7300 does not exist.

Select the COM port of the CI-V cable (seen in the Control Panel of the PC "Prolific USB to serial
Comm Port")

Choose the rate (Speed) you wrote when visiting the Connector / CIV menu and address CIV Menu,
set, connector, VIC, Mark DTR and RTS

New Preset I Serial Ports I Help

Company: {ICUMi'] [ Status
Radio: [W"‘
COM Port (COM4 v
Speed: 19200 'J
CIiVAdd 714 R

Flow control / Interface power

cTs [VDTR WIRTS

[] Always connect to this radio when stating HRD Start [ Digital Master 780
| Start HRD in Full Screen mode [7] Logbook
| [ Rotator
Connect ["] Satelite Tracking

Then click CONNECT, the IC-7300 is found by HRD and displays the current frequency on the
tranceiver.
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Configuration in HRD / DM780

Click the "program" option Click PTT in the left menu. Select "Via HRD -DM780 must be connected to
HRD" and click Configure "HRD connection"

Flle Edit View QSO Browser Logbook SSTV SuperSweeper WorldMap Tools Window Help
%2 & 2 3

QS.O SuperSweeper  Radio Soundcard
w x| s

Appearance PIT
Callsign (My Info) ~
ot 1) compat [ —— 7 compot
Let ROC key the
Logbock o Ol Logboak
Modes « 105 Modes + IDs
Nore
) via soundcard
;‘;2" FTT orrado VOX ;‘;a"’
Soundcard . Soundcyd o
Sounds oM - CONPoit =

Port
To use & COM port for PTT: To use a COM port for PTT:
= Select via Serial (COM) port
+ Select the COM port; this must not be in use by another program,
* Select OTR, RTS or DTR and RTS.

3 Select vis Sera! (CON) port
* Select the COM port; this must

ot be in se by another program,
LS T A Grm s AT

When y0u swech o TX OTR and/or ATS are set (rised), whan you retun o X they are i When you swich to TX OTR andlor ATS are set (rised), mhen you returnto X they are
Macros..
Note: this port cannot be used by anather program such as HRD - it must be available for | Note: this port cannot be uzed by snather program such as HRD - i must be avadable for
exclusive use by DM780. v exclusive use by DM780.
Navigator...
Ham Radio Deluxi Audio Recorder. Ham Radio Deluxe
YﬂmNRDmerﬂmmummumm&deD PSK Reports e To use HRD the radko pane must be connected to HRD:
..
+ Inthe View menu select Radio Soundcard Cafbotion.. + In the View menu select Radio
* In the Radio pane press Configure and read the instructions! * In the Radio pane press Configure and read the instructions!
The Radio must be abie to support the TX command i s CAT control. Time Synchronisation.. * The Radio must be able to support the TX command 1 12 CAT control
Note: If you use Mam Radio Deluxe for PTT and you connect the sudio via a rear Note: If you use Ham Radio Deluxe for PTT and you connect the audio vis a rear
connector (not the microphone connector) make sure your radio will accept sudio via the connector (not the microphone connector) make sure your radio will accept sudio via the
rear connector when using PTT via & software command, some ri - rear connector when using PTT via & software command, some radios M as the TS-
2000 wil et 2000 wil net! ]
> -
9

Click "Connect" if the connection between HRD and DM780 is Ok, you have all the buttons display
(Right photo). IF OK, check "Automatically connect"

Configure Radio Pane: Not Connected

HAD User Inter Bl )

e Connect to HRD User Interface 2 e Connect to HRD User Interface  *
Address:  |localhost Address: |localhost
Pat: (7809 Ham Radio Deluxe: Pot (7809 Ham Radio Deluxe:

ic sl 1 The connection uses TCP/IP - you must have [¥] Automaticaly connect 1 The connection uses TCP/IP - you must have
TCP/IP started. TCP/IP started.
.
2 Make sure Ham Radio Deluxe (HRD) is started 2 Make sure Ham Radio Deluxe (HRD) is started

to a radio (you must use build and connected to a radio (you must use build

=]

@

an
1317 or later).

connect to the 1P Server).

Configure Radio Pane:

where the HRD User Interface is running,
connect to the local computer, the actual
network address is shown in the IP Server
window.

Do NOT enter the address of the HRD

Interface address. Even if HRD is

3 InHRD select IP Server from the Tools menu,
make sure the IP Server is started (DM780 will

1 Address - the address or name of the computer

localhost (or 127.0.0.1) can usually be used to

Remote Server, always use the HRD s

|

1317 or later).

connect to the IP Server).

Configure Radio Pane:

window.

User Interface.
selected in the IP Server window.

made to connect to HRD when the program

a remote radio, you always connect to the o

2 Port - the default port is 7809, use the same port

3 Always connect to HRD - if checked an attempt is

starts even if not connected when the previous

PTT - Select Program Options' from the ‘T ools' menu

)
|

User Interface.

selected in the IP Server window.

3 In HRD select IP Server from the Tools menu,
make sure the IP Server is started (DM780 will

1 Address - the address or name of the computer
where the HRD User Interface is running,
localhost (or 127.0.0.1) can usually be used to
connect to the local computer, the actual
network address is shown in the IP Server

Do NOT enter the address of the HRD
Remote Server, always use the HRD User
address. Even if HRD is connected to
a remote radio, you always connect to the HRD

2 Port - the default port is 7809, use the same port

3 Always connect to HRD - if checked an attempt is
made to connect to HRD when the program
starts even if not connected when the previous

(& PTT - Select Program Optians' fiom the ‘Tooks' menu

5]
|

Click " Modes+ IDs "

(v Gewgsunsd ]

e Gl n BSI0) | Wdea D)
Cal Inf
c:e?(w " Hep | Code Table [AUse PTT  See shho: PTT
There are four CW veriants: <3}
CW doss rt suppor o charscters on
« Standard CW where the 3 is keyed via 3 serial or your koo ee table] § an
paraliel port inappoted chavacter & enterd
+ Hoduated cw Gl (W) where the tones are generated B
+ Uk the XY command with Elecrat, Kenmood and Dlsent

Pexchato redios (reed the PTT miorm

+ Using the KIEL Winkeyer.

With standard CW the radio is keyed by  serisi port (DTR
and/or RTS) or a parallel port (Data pins 2 to 8 or Select pin
17). Note - the serid! port can used by ancther

not be —

application such a5 Ham Radio Deluxe,  must be reserved for Wk P> (@
wih standard CW the soundesrd

stays in receive mode, o tanes are generated. To generate

CW tones use MCW.. [ Enable senal (COM) port keyng

e samsie keying craits see o)
itot /e, oot comiciaca.tem
- L Toggeprs  [ZIOTR [IRTS

To ensure accurate timing the background thread used for

Audic Recorde... serial and parael port keyer runs at a time critial prionty
PSK Reporter Just one step below real-time (] Enable parale post keyng
Soundcard Cakbration.. P1T

YimeSynchessisstion.. If checked the radio is switched between TX and RX using the

selection in the PTT page, f not checked then use VOX /
brealan.

When using the KY Command with Kenwood and Flex-
Re00 vou haark sa VON / briaide 6 thace Io wo wey
of knowing when all characters have been sent so that 'y

in the left menu. Select "Use PTT" and "Enable Serial (COM) Port keing". Fill with
your USB cable port number (Com5) and DTR
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Click "Soundcard" in the left menu.

Select "microphone (USB Audio Codec) and speakers (USB Audio Codec). This is the sound card
created by the 7300 IC and USB cable

Program Options

Appearance “Soundoard |
Callsign (MyInfo)

0 By Jnfo) Fout (Receive) — |
Gosk Input (Receive) &l
Logbook Devics: | Microphane (USB Audio CODEC) v] Device: Select the soundcard used
Modes + IDs = for receiving signals, the line in is

& connected to the audio output from
Ly your radio.
B Source: Select the input
urce: Select the input source -
gsC ot e usually Line in. This fader is shown
| in the soundcard’s RX pane, use it
Sounds e lan o adjustthe nput level. ok ol
ave input sources - for
storage el | | Sampie the Sionatink Uss aoe
SuperSweeper ot have any user-selectable input
Watcral Output (Trense)
Qutput (Transmit)
Alarms... ©0B8 O258 OB O10d8 O158 O20d8 Device: Select the soundcard used
Fitioiies for transmitting signals, the speaker
e output is connected to the audio
acros... e input on your radio. This is normally
Modes... El o ssmis s i sl o the same as the input device.
e [(SouSeereifanss ]
Show Supported Fomals Source: Select the output source -
usually Wave, This fader is shown in
Audio Recorder... the soundcard's TX pane, use it to
PSK Reporter adjust the output level.
Soundcard Calibration.. For recording and payback of wave fies ses: Recordng Output Attenuation
T hr . f your radio i very senaitive apoly
ime Synchronisation. o et e Yo menatii e o

use of the faders much easier.

Show sample rate...
Shows the current effective sample
rate in the main status bar, this is

[P e—rm———— 2]

Once this is done, left DM780 and HRD. Then restart to see if the settings have been saved.

You will be able to emission testing, cw, rtty, psk, etc. via DM780. Think of the USB mode Data for
digital modes against CW remains the CW.Mind your modulation level and ALC for USB-D


http://www.ra88.org

()

8 S8S.0RCG

N1MM configuration (soft CW & SSB contest)

Install NIMM: https://n1mmwp.hamdocs.com/

Once installed, restart your PC and then start NIMM
@059,00 CW Manual - VFO A = x 3 Eonﬁgum Ports, Mode Control, Audio, Other... I

has Yo q ta...
File Edit View Tools Window  Help f"gg :";S‘:':"D’
ogger Audio Setup...

CQ-Frequency Snt Rev Exch JP] Use Logger+ Audio
Manage translations... i

cw
160

o Enter Sends Message (ESM mode) CuleM
o @ @ CRn Oste 2 3 Spot All S&P Q50's
2 [Trcva | reeeh | P | Fécwxe FSHisCal || F6Repeat | [l oxrms s o cat s e 020 & e o
e Grab Focus From Other Apps When Radio is Tuned
[ Frwexz ][ reagn? || rowz ][ sssmscar |[ Fricawss || Frawipe | Do Not Automatically Switch to Run on CQ Frequency

1
Esc: Stop wipe ][ Logt Edt ark [ Store | spotr [ arz 7 Show Non-Workable Spots and Dupes in Bandmap

No Heading Reset RX Freq to TX when QS0 is Logged (Run & Split)

IL 163/38/33 35571 (7] corepest AR
- Set CQ Repeat Time (ms) (3000) Cul+R

CW / PH AutoSend Threshold...
Enable Call History Lookup
Change CW/SSB/Digital Function Key Definitions »
Change Band Plan »
Manage Skins, Colors and Fonts...
Change Operator Calisign Stored in Log c+0
Change Exchange Abbreviations »
soR ,
WAE >

Clear *.ini File Settings

Choice No. X Port com about your USB cable and the radio model (IC-7300)

Select CW / other and click "SET"

PR == ® B 1 ComS ==
Warbmas | Punconeya] Optaiede | Oer | ke | ot cott | Artses | Scre g roness e | WTiTox Sk Speed Party | petts  swpsis
18200 <J|(n v|[e -] (4 -
Mmoo omee oum Sl pmerh e I [ Je oo
1200881 STRCHRTSPTT | TR (on 4 RTS (in7)  Jicom Code (hex)] Radio Nr
SRR - [ - % | oW v |jlrrT N Kl v
o - = =
couz - e s - | ERTDSY (e ] Enable Both Hardware & Software PTT
Nooe v Mene - : Il *° [] PTT via Radio Command SSB Mode
[ - | 1 Ao (] PTT via Radio Command CW Mode
S0 - ,
oo < hene - L . I © J [7] PTT via Radio g
e : | Tuo Rado Prtocs - FootSwich (506)
- s |
Ty Radio Polling Rate
‘Suggested icom Setings:
9600 - 19200, N, 8, 1, Always Off, Always Off, icom Hex Code
DTR RTS shoud be Always On with a COM port powered interface.
Set the radio to the same speed or auto-baud.
Set the radio CLV Transceive option to OFF.
[eoncer] |
ok | [ conce oo | R e T
— = |

You will be able to configure your Com Port No. X with different parameters (speed, CI-V address,
RTS, DTR

e Speed: Value "CI-V USB Baud rate" noted in the IC-7300 menus: Set> connector> CI-V

e DTR (Pin4): Select CW. IC7300 Menu: set> connector> USB Send / Keying

e RTS (Pin 7): Choose PTT. IC-7300 Menu: set> connector> USB Send / Keying

e Icom Code (Hex): Value "VIC Address" IC-7300 Menu: set> connector> VIC

e You can also choose the other parameters: allowed other software to use PTT, PTT via radio
command SSB, Cw, Digital (up to you, | have not checked anything)

Click OK and then OK again on the "configure"

Exit NIMM.
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Restart it, and see if the frequency of Tranceiver appears well on the top left

I8B8059,00 CW Manual - VFO A = =

File Edit View Tools Config Window Help
CQ-Frequency Snt Rev Exch

©® @ oRn Oste 2 3

?: [ Facva [ Feexch | F3Tu || Fécvaxe ][ Fstiscar ][ FoRepest |
[ Frwee ][ rsagnr || Fomz ][ sosmscar | Frcawss [ Fizwipe |

. Esc: Stop wipe J[ Loge J[ Eae uark | store [ spote [ arz

No Heading

I 163/38/33 35571

If this is the case is that the CAT system is OK.

Now recreate a database and a log for a CW contest .... Once this is done, put a sign here and click on
"exchange" or press the F2 key, theoretically IC 7300 should send the "code followed by the
postponement and / or serial of the contest" Otherwise click the button 1 button or press the F1 key

@uss,oo CW Manual - VFO A = =

Fie Edit View Toolks Config Window Help

snt Rev Exch

©® @ oRn Oste 2 3

?: [ Facva [ Feexch | F3Tu || Fécvaxe ][ Fstiscar ][ FoRepest |
[ Frwee ][ rsagnr || Fomz ][ sosmscar | Ficawss [ Fizwipe |

. Esc: Stop wipe J[ Loge J[ Eae uark | store [ spote [ arz

No Heading

I 163/38/33 35571

For the configuration database, log, report, serial contest, | have little time to do a tutorial for now.
But according to the demands and my available time, why not.

Good fun

73 FACVQ Vincent

And thank you for visiting our website departmental amateur

www.ra88.org

HRD/DM780 & N1MM

par FaCvQ
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PERSONAL NOTES:
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